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Unpacking Instructions for the

KODAK PROFESSIONAL

HR 500 Plus and Universal Film Scanners

CAUTION: The HR Film Scanner weighs almost 120 Ibs (54,5 kg). Two people are needed to safely lift the

scanner from the box.
The table for the scanner must be:
+ stable

» able to support approximately 120 Ibs (54,5 kQ)
e atleast 30in. (76,2 cm)long x 30 in. (76,2 cm) wide

=

styrofoam

scanner in
plastic bag

cutouts
styrofoam

under scanner

front
compartment
with
accessories
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1. Inspect the box to make sure there is no damage.
If there is damage, contact the shipping company.
2. Remove the lid from the box.

3. Remove the scanner accessories (such as cables
and the SCSI board) from the front compartment of
the box.

4. Compare the packing list to the contents.

If there is an item missing:

* In the United States: call Eastman Kodak
Company at 1-800-822-1414.

< Outside the United States: contact your local
Kodak representative.

5. Open the plastic bag that covers the scanner and
move the bag to reach the cutouts in the styrofoam
under the scanner.

CAUTION: Two people are needed to lift the scanner
from the box.

6. Use the styrofoam cutouts to reach under the scanner
(one person in front; one person in back) and lift the
scanner from the box onto the table.

7. Keep the scanner packing material until you are
satisfied that the scanner is operating correctly.

CAUTION: The setting on the AC input module on
the back of the scanner must be
compatible with the power source.
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Regulatory Information

This equipment has been tested and found to comply with the limits for a Class A
device, pursuant to part 15 of the FCC rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause interference; in
which case, the user would be required to incur the expense of correcting the
interference.

If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures.

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and the receiver.

* Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.
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English: This is a Class A product based on the standard of the Voluntary
Control Council for Interference by Information Technology
Equipment (VCCI). If this equipment is used in a domestic
environment, radio disturbance may arise. When such trouble
occurs, the user may be required to take corrective actions.
May 2002
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Regulatory Information

Cautionary Symbols

Vi

Hot Surface Symbol

CAUTION: Risk of burn. Wait at least 5 minutes for the surface to cool.

Fuse Label

A (2) 100-120 V 50/60 Hz 6.3 A/250V | F
= (2) 200240V 50/60 Hz 3.15A/250V/T

CAUTION: Double pole / neutral fusing.
ATTENTION: Double pdle / fusible sur le neutre.
ACHTUNG: Zweipolige bzw. Neutralleiter - Sicherung!

CAUTION: The scanner uses double pole/neutral fusing.

Electrical Hazard Symbol

French:
Symbole de Danger Electrique

German:
Elektrisches Gefahrensymbol
CAUTION: Risk of electrical shock. Test before touching.

French:
ATTENTION: Danger D’ Electrocution. Vérifier avant de toucher.

German:
VORSICHT: Gefahr von elektrischem Schlag. Vor Bertihrung prufen.

May 2002
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Regulatory Information

Mechanical Hazard Symbol

French:
Symbole de Danger Mécanique

German:
Mechanisches Gefahrensymbol
CAUTION: Moving parts. Avoid contact.

French:
ATTENTION: Pieces en mouvement. Ne pas toucher.

German:
VORSICHT: Bewegliche Teile. Nicht berthren.

Warranty Information

May 2002

The following warranty information pertains to equipment that is installed in the
United States only. For equipment installed in countries other than the United
States, the terms and conditions of the new equipment warranty are provided by
the Kodak company in the country in which the sale is finalized, or by a Kodak-
appointed distributor in those countries where Kodak does not have direct sales
representation.

Warranty Period

Kodak warrants new equipment to function properly for 90 days from the date of
initial installation. This warranty covers the purchaser of the equipment as well as
anyone else who owns it during the warranty period.

Warranty Repair Coverage

If this equipment does not function properly during the warranty period, a Service
and Support Field Engineer from Kodak will repair the equipment without charge
during Kodak’s normal working hours (usually 8:00 a.m. to 5:00 p.m., Monday
through Friday). Such repair service will include any adjustments and/or
replacement of parts required to maintain your equipment in good working order.
Supply items are billed as required.

How to Obtain Service

Before you call, please know your scanner’s K-Number. The K-Number label is
attached to the front of the scanner chassis near the filter and lamp; lift the lamp-
and-filter-access door to see the K-number (see Front View on page 1-4).

For service and support:
* Inthe United States: call Eastman Kodak Company at 1-800-822-1414.
¢ Qutside the United States: contact your local Kodak representative.
vii
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Regulatory Information

viii

Limitations

Warranty service is limited to areas within Kodak’s established marketing centers
in the contiguous United States, the island of Oahu in Hawaii, and some areas of
Alaska.

This warranty does not cover circumstances beyond Kodak’s control; it does not
cover service or parts for any attachments, accessories, or alterations not
marketed by Kodak, nor to correct problems resulting from their use.

Damage caused by failure to meet the electrical specification in this manual is not
covered under the warranty to service agreement claim.

Kodak makes no other warranties, express, implied, or of merchantability,
for this equipment.

Repair or replacement without charge is Kodak’s only obligation under this
warranty. Kodak will not be responsible for any consequential or incidental
damages resulting from the sale, use, or improper functioning of this equipment,
even if loss or damage is caused by the negligence or the fault of Kodak.

Such damages, for which Kodak is not responsible, include, but are not limited to,
loss of revenue or profit, downtime costs, loss of use of the equipment, cost of any
substitute equipment, and facilities or services of claims of your customers for
such damages.

This limitation of liability does not apply to claims for injury to persons or damage
to property caused by the sole negligence or fault of Kodak or by persons under
its direction or control.

Kodak Service Agreements

For information on Kodak service agreements:

In the United States: call Kodak's Service Marketing Contract Administration and
Billing Support at 1-800-645-6325.

Outside the United States: contact your local Kodak representative.

May 2002
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About This Guide

This User’s Guide for the KODAK PROFESSIONAL HR 500 Plus Film Scanner
and the KODAK PROFESSIONAL HR Universal Scanner includes procedures for
operating, maintaining, and troubleshooting the scanner. It also includes an
appendix for the optional Long Roll Accessory.

This guide is intended for personnel who operate the scanner. It assumes you
have a basic knowledge of computer operations and film scanners.

Using This Guide

Chapter 1

Chapter 2

Chapter 3

Chapter 4

Appendix A

Appendix B

Appendix C

Appendix D

May 2002

Introduction—product description, features and benefits, equipment
overview, and recommended configuration

Connecting and Operating the Scanner—connecting the scanner to
the host computer, starting up the scanner, preparing to scan an image,
performing a scan and shutting down the scanner

Validating the Scanner—instructions for using the Service and
Assembly Module (SAM) and Adobe PhotoShop software to validate that
the scanner functions properly

Maintaining the Equipment—procedures to be done by the person in
your lab who is responsible for maintenance of the scanner

Using the Service and Assembly Module (SAM)—an overview of
using SAM for validating the scanner and for other user functions

Ordering Accessories and Supplies—includes descriptions and order
numbers for scanner accessories and supplies

Scanner Specifications—includes space, electrical, and environmental
requirements for the scanner

Using the Long Roll Accessory—instructions for installing and using
the (optional) Long Roll Accessory with the scanner

xi
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1 Introduction and Overview

This chapter includes:

* product description

» features and benefits

* equipment overview

« recommended configuration for host computer
o film sizes

Product Description

May 2002

With the Kodak Professional HR 500 Plus Film Scanner and the Kodak
Professional HR Universal Film Scanners, you can quickly generate high-
resolution digital images from photographic negatives and positives.

You can digitally capture images and store them in files up to 128 MB (format
dependent) in size. The scanner is capable of variable magnifications from
0.510 2.0.

The new DIGITAL ICE technology corrects blemishes and defects on negatives
and reduces your post-print retouching time.

With the HR 500 Plus Film Scanner, you can use films ranging from 35 mm to 70
mm widths, including 46 mm width film and the 120 series formats, with up to 90
mm frame lengths.

With the HR Universal Scanner, you can use all film formats, from 35 mm to 70
mm widths, including 46 mm width film, the 120 series formats, and 4 x 5 sheet
film, with up to 125 mm frame lengths.

How the Scanner Works

The image on the film is focused onto a Charged Coupled Device (CCD) that has
three parallel linear rows of light-sensitive elements, one row for each color. Each
of these lines is exposed to a corresponding line of image on the film. The time to
expose each line properly is controlled electronically and is a function of the:

* sensitivity of the CCD

e amount and spectral distribution of light from the light source

* lens aperture

e magnification factor

After the exposure, the data from the photosensitive sites on the CCD is
transferred to readout registers for each line, where it is then shifted out and
digitized one pixel at a time. While the data is shifted out, the next set of lines is
exposed.

The film is moved to expose a new line of the image for each set of lines read from
the CCD. This motion is precisely controlled to ensure that the aspect ratio of the
image is not changed and that the colors align correctly when the data is
recombined to correct for the distance between the sensor rows.

1-1

Download from Www.Somanuals.com. All Manuals Search And Download.



Introduction and Overview

Features and Benefits

Features and benefits of the HR 500 Plus and Universal Film Scanners include:

1-2

high speed and high image quality digital capture

handling of cut negatives, mounted slides, strips, short rolls, and long roll
lengths up to 200 feet (61 meters)

compatibility with familiar software, such as

— Kodak Professional Digital Print Production Software (DP2)

— Kodak Professional HR 500 TWAIN Data Source, which can be used with
any TWAIN-compliant program

compatibility with familiar hardware, such as Kodak Professional Digital
Multiprinters and Kodak Professional LED Printers

the new DIGITAL ICE technology that corrects blemishes and defects on
negatives and reduces your post-print retouching time

the ability to store calibrations, resulting in improved workflow

May 2002
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Before You Begin

Itis important that you know when to calibrate and when to focus the scanner. The
table below is a guideline for calibrating and focusing. Focusing can occur as

May 2002

infrequently as when a different film format is scanned or as frequently as every

Introduction and Overview

scan.
. - Need to Need to
Action or Condition ]
Calibrate? Focus?
Changing the magnification Yes* Yes
Replacing the lamp Yes No
Changing the balance filter position from negative Yes Yes
to positive or from positive to negative
The scanner has not been calibrated at least twice Yes* No
during the first half of a production shift
Cleaning the light bar Yes No
Replacing the balance filters or the IR filter Yes No
Changing the film holder size without changing the Yes* Operator
magnification Preference
Scanning slides and aperture cards No Operator
Preference
Changing from scanning a long roll to scanning a Yes Yes

cut negative

* The need to calibrate partially depends on whether you are using stored
calibrations and the length of time the calibrations are stored (usually about 3

hours)

You can manipulate scanned images using a program such as the Kodak
Professional Digital Print Production Software (DP2) or the Kodak Professional
HR 500 TWAIN Data Source before sending the images to your digital printer.

Download from Www.Somanuals.com. All Manuals Search And Download.



Introduction and Overview

Equipment Overview

Front View

K-number is
visible when this
door is open

Rear View
/m | ﬁ\
® ® @ o
Go—H ﬁﬁﬂ%er XXX
@ @ Q o
J

LL M@Jﬁ; : - s
| X =

power switch latch release dataplate includes
screw serial number
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Recommended Configuration of the Host Computer

The scanner is only certified to communicate with Windows NT and Windows

Introduction and Overview

2000 platforms with the following configuration.

IMPORTANT: To ensure proper operation of the scanner, use the Ultra-Wide

SCSI board provided with the scanner.

Built-in SCSI interfaces in some computers may interfere with the
provided Ultra-Wide SCSI board.

Host Computer Hardware Requirements

A SCSI cable connects the host computer to the scanner. This interface enables
the transfer of digital image data from the scanner to the host computer.

If you follow the recommended host computer hardware requirements, you can

expect higher performance.

IMPORTANT: The SCSI board must be dedicated to running only the HR Film

Scanner.

Minimum

Recommended

Dual Pentium 111/600 MHz

Dual Pentium Il or IV/1.2 GHz

512 MB memory

1 GB memory

10 GB available disk space

40 — 60 GB available disk space

CD-ROM drive

19- to 21-inch Color Monitor

24-bit Color Display Card with at least 16 MB video RAM

Dedicated SCSI host adapter (provided with scanner)

High-speed internet connection

Recommended Software Requirements
* Windows NT 4.0 or Windows 2000, Service Pack 6 or 6A for using the

scanner and software

e Microsoft Internet Explorer 5.01 or higher
» Adobe Photoshop 5.5 or higher for validating operation of the scanner

May 2002
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Introduction and Overview

Film Sizes

1-6

Commonly available color negative, color reversal (positive), and black-and-white

films are supported by the scanner.

Both the HR 500 Plus Film Scanner and the HR Universal Scanner accept these

film sizes:
e 35mm

— standard perforated format

— un-perforated, up to 60 mm frame length
e 46 mm, up to 90 mm frame length
e 120/220 (62 mm)

— 6x45cm

— 6x6cCcm

- 6x7cm

— 6x8cm

— 6x9cm
e 70mm

— split 70 mm

— full 70 mm

Additionally, the HR Universal Scanner accepts 4 x 5-in. sheet film.

Film Holders Provided with the Scanner

Cut-gate film holders for these film sizes are provided with the scanner:

* 35 mm double-perforated

e 35 mm mounted slides

e 70 mm-CAL with the HR 500 Plus Film Scanner
e 4 x5 with the HR Universal Film Scanner

e 6x4.5cm vertical

e 6x4.5cm horizontal

e 6X6Cm
e 6X7cCm
e 6Xx9cCcm

Download from Www.Somanuals.com. All Manuals Search And Download.
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2 Connecting and Operating the Scanner

This chapter gives instructions for:

preparing the host computer

connecting the HR Film Scanner to the host computer
starting up the scanner system

preparing to scan an image

performing a scan

shutting down the scanner

Preparing the Host Computer

CAUTION: Do not connect power to the scanner.

May 2002

1. Install the Ultra-Wide SCSI board into the host computer.

IMPORTANT: Check the README file on the CD before you install the
software.

2. Install the SAM software. See Installing the Service and Assembly Module

(SAM) Software on page A-2.

2-1
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Connecting and Operating the Scanner

Connecting the Scanner

2-2

CAUTION: Make sure the setting on the AC input module on the back of the
scanner agrees with the power source.

Mm

AC input module

The AC input module is factory-set to 115 V AC (60 Hz) as labeled. The
accessories shipped with your scanner include two 220 V fuses (3.15 amps) to
convert the scanner to 220 V operation.

If your power source is 220 or 230 V AC, verify the configuration of the AC input
module. In some regions, the setting and the fuses may have been changed for
you. If not, follow the procedure for Changing the AC Input Voltage Setting and the
Fuses.

Remove the voltage sticker from the AC input module.

May 2002
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Connecting and Operating the Scanner

Changing the AC Input Voltage Setting and the
Fuses

If needed, change the AC input voltage setting (voltage selector switch) and both
fuses from 115 V AC to 220 V AC operation:

1. Make sure the power cord is removed from the scanner.

locking tab

/

voltage selector switch

2. Insert a straight-blade screwdriver into the locking tab to open the AC input
module.

3. Using your fingers (or, if needed, needle-nose pliers), remove the voltage
selector switch.

4. Orient the voltage selector switch with 220 V AC facing you and insert it into
the AC input module.

2-3
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Connecting and Operating the Scanner

5. Remove the two 115 V AC (6.3 amp) fuses and replace them with the
220 V AC (3.15 amp) fuses. Make sure the arrows are pointing up.

fuse in holder

6. Close the AC input module.

2-4 May 2002
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Connecting and Operating the Scanner

Attaching the Cables

CAUTION: In the next step, avoid forcing the cable pins when plugging the
cable into the scanner. You need a straight-blade screwdriver to
complete the attachment of the cable to the scanner.

1. Attach the Ultra-Wide SCSI cable to the scanner and to the host computer.
The host end of the cable contains ferrite beads.

2. Attach the power cable from the scanner to the power source.

m

SCSI
cable

® o

ferrite beads

2-5
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Connecting and Operating the Scanner

Starting Up the Scanner System

NOTE: If the scanner’s power has been on and the scanner has been calibrated,
continue with Operating the Scanner beginning on page 2-8.

IMPORTANT: Before operating the scanner in a production environment for the
first time, validate that the scanner is working properly. See
Chapter 3, Validating the Scanner.

Placing the Empty Film Holder in the Film Holder
Guide

The empty film holder must be in place in the film holder guide when you power up
the scanner.

Film Holder for Film Holder for
HR 500 Plus Film Scanner HR Universal Film Scanner
70MM-CAL 4x5

edge of handle facing back
of scanner

70MM-CAL film holder

film holder guide

1. With the edge of the top handle facing the back of the scanner, center the film
holder between the two rails of the film holder guide.

2. Lower the film holder and let it gently fall into place in the scanner.

3. With your finger, apply pressure to the handle to make sure the film holder is
fully seated.

2-6 May 2002
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Connecting and Operating the Scanner

Powering up the Scanner and the Host Computer
1. Turn on the scanner’s power switch.

NOTE: The green LED light on the scanner indicates only that AC power is
supplied to the scanner, not that the system is ready.

Three sets of beeps will sound (first set: one beep; second set: two short
beeps; third set: two short, then one long beep).

As a visual indicator that the scanner is ready, the scanner lamp lights and
remains lit.

2. Turn on power to the host computer and wait until the computer desktop

appears.
3. Wait 10 minutes for the lamp to warm up.
m
@ ® @ o o
® (-] ] I
@
H (-] ]
5t
7

power switch

2-7
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Connecting and Operating the Scanner

Operating the Scanner

2-8

Setting the Magnification and Calibrating the
Scanner

Use your host computer’s scanner software to do this procedure.

NOTE: The terminology used in your scanner software may differ from that used
in this document. Refer to the software manual’s instructions for performing
specific operations such as calibrating the scanner and setting the
magnification.

With the empty film holder (7OMM-CAL for HR 500 Plus and 4 x 5 for
HR Universal) in place in the scanner:

1. Set the magnification to the desired level.
2. Calibrate the scanner.

Setting the Scan Parameters

Using the software installed on your host computer, set the scan parameters, such
as the area to be scanned and the file that will contain the scanned image.

Selecting the Negative or Positive Balancing Filter

lamp-and-filter-
ess door

lift door open from
here

1. Lift open the lamp-and-filter-access door.

May 2002
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Connecting and Operating the Scanner

2. Make sure the red handle is in the correct position—either negative or
positive—for scanning a negative or a mounted slide (positive).

IMPORTANT: If you changed the setting of the balance filter, you must
calibrate the scanner before continuing. See Setting the
Magnification and Calibrating the Scanner on page 2-8.

\red handle is in
NEG position

2-9
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Connecting and Operating the Scanner

Placing a Negative or Mounted Slide in the Film
Holder

Select the appropriate film holder for the negative or mounted slide you will be
scanning.

Preparing a Carded Negative

IMPORTANT: For best focus, use the film holder that is closest to the size of the
opening in the aperture card.

1. Lift the film holder’s magnetic sheet.

IMPORTANT: In the next step, the emulsion side must be toward the rear of the
scanner.

2. With the emulsion side toward the rear of the scanner, locate the carded
negative on the film holder’s two pins.

3. Carefully close the magnetic sheet over the carded negative.

emulsion
side

carded
negative

magnetic
sheet

2-10

pin

film holder

Continue with Placing the Film Holder in the Scanner on page 2-12.
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Connecting and Operating the Scanner

Preparing an Uncarded Negative

Wear clean, cotton gloves when handling the negative. llluminate the negative
with a light box or hold the negative up to the light to view and align the negative.

1. Identify the emulsion side of the negative.

The emulsion side is the dull side of the negative. The printing appears
backwards.

2. Select either landscape or portrait orientation.
3. Lift the magnetic sheet.

IMPORTANT: In the next step, the emulsion side must be toward the rear of the
scanner.

4. With the emulsion side toward the rear of the scanner, carefully align the
negative over the rectangular opening in the film holder.

5. Close the magnetic sheet over the negative.

Continue with Placing the Film Holder in the Scanner on page 2-12.

Preparing a Mounted Slide

IMPORTANT: In the next step, the emulsion side must be toward the rear of the
scanner.

1. With the emulsion side toward the rear of the scanner, align the mounted slide
on the film holder between the pins.

2. Carefully insert the mounted slide under the film holder’s clamps and into
place, keeping the slide aligned.

2-11
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Connecting and Operating the Scanner

Placing the Film Holder in the Scanner

1. Hold the film holder guide so the top handle faces the back of the scanner.
Center the film holder between the two rails of the film holder guide.

2. Lower the film holder and let it gently fall into place in the scanner.

3. With your finger, apply pressure to the handle to make sure the film holder is
fully seated.

edge of handle facing back \
of scanner
Q film holder
Q
t film holder guide
T

4
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Connecting and Operating the Scanner

Focusing
With the negative or mounted slide installed in the scanner, use the software
installed on your host computer to focus the scanner.

IMPORTANT: The need for focusing is partially dependent on the “depth of field.”
When the magnification is lower—for example, 0.5—the depth of
field is greater and the focus tolerance is high. As the magnification
increases, the depth of field and the focus tolerance decrease.
Therefore, it may be necessary to focus more frequently for higher
magnifications.

Scanning a Single Frame

Using the software installed on your host computer, scan the negative or mounted
slide.

Shutting Down the Scanner

Follow this procedure when you do not plan to use the scanner for extended
periods of time, such as over the weekend.

1. Close the host software program.
2. Turn off power to the scanner.

May 2002 2-13
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Connecting and Operating the Scanner
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3 Validating the Scanner

This chapter includes instructions for using the Service and Assembly Module
(SAM) and Adobe Photoshop software to validate that the scanner functions
properly.

NOTES: For more information about using the Service and Assembly module
software on the host computer, see Appendix A.

Before scanning for the first time, set up a folder (on your host
computer) for your work. Especially if you have more than one scanner,
include the scanner serial number (on the dataplate on the back of the
scanner) in the folder name.

IMPORTANT: The empty CAL film holder (7OMM-CAL for HR 500 Plus Film
Scanners and 4 x 5 for HR Universal Film Scanners) must be in
position in the scanner before you start SAM. See Placing the
Empty Film Holder in the Film Holder Guide on page 2-6.

May 2002 3-1
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Validating the Scanner

Starting the SAM Software

1. Open SAM. The Operations window appears with the Mag/Focus tab
displayed.

Operations

I+ £ =] i e =) R =R O o=t ) e B ]
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Validating the Scanner

2. Perform a backup of the scanner files:
a. Click the Backup & Restore tab.
b. Click Backup.

Operations

Era FHESIETE
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Validating the Scanner

Setting the Magnification

1. Click the Mag/Focus tab.

Operations

¥ | Granfi Fosus BualtrEEes P e e i e

2. Select a Chosen Magnification of 1.00.
3. Click Do Magnification.
The lens moves into position.
A message appears stating that there is no stored calibration.
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Validating the Scanner

Calibrating the Scanner

1. Click the Calibrate/Image Processing tab.

Operations Ed |

Miscellansous I Diagrostics | Sensors | Motors & Solenaids I Backup & Restore
b ag/Focus Calibrate/Image Frocessing | Capture I Transfer

— Image Froceszing
—DataPath———— ~Dmin Setthge————  — Colarz Selected
= Color Negative " Disabled * RBGE
" Color Reversal = Lse Defaults  Bed
_ - " User Selected
LLIFT Selected FEI JElECte " Green
Dizabled
nz 0.45 Qe
' Log [Intemal] I I I ' Blue
¥ Enable Dark and Gain Corections ¥ Shift Image Data Bits Up by Four
¥ Enable Defective Pitel Conceal

— Calibration Fesultz

Expozure Time: 000122 Line Length: 6100 Calibrate Al
Red Resst 2967 =

First Walid Fizel:  5EE Green Reset: 2683 Dark. Calibrate

Last Walid Pixel: 5404 Blue Reset: 280

IF Slape: B | Wi Calmetion Lags Bl Lol Lol

—Maon-Linearity Factars
Red: Green: Blue: IR: Calibrate ﬂnn-Linearityl

Graph Gain Carections Graph Dark Caorections |

2. For the purposes of validating the scanner, make sure the values on the
Calibrate/lmage Processing tab match the values shown on the sample. The
sample is a representation of the default values.

3. Select Shift Image Data Bits Up by Four.
4. Click Calibrate All.
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Validating the Scanner

Making a Test Scan

Before you scan an image, you must identify the area to be scanned and the file

that will contain the scanned image.
1. Click the Capture tab.

Operations |
Mizcellaneous I Diaghostics I Sensors I Mators & Solenoids | Backup & Restare
Mag/Focus I Calibrate/lmage Procezsing Capture | Tranzfer

—Scan Area — Save Image to Hozt Computer
HPFixels (dx): W ¥ Save image bo file
Fixel Offset [x]: W Path: I
Hlines (dyf 2000 |
Line Offset [0 Fle Siee: B
Pived Summing: Im Actual #Piels 0
™ 45 Film Size Actual Hlines: 0 WpErEge |
— Predefined Setupz Cuick Calibrate & Focus
Select Setup: Iﬁ EditSetup |
- _ Calibrate &l | Focus |
[ Set Magrification Automatically
—5Scan Type Scan
- o s Pttt || f15cons PerFiame [
O Internal Test Pattern $#2 B [ T P [ ey Sean
" Live Image Infrared Data
— Single Line Scan
[T Single Line Scan ™| Graph Szan Line Density Erafie
2. Enter the file information:
a. Select Save image to file.
b. Click Browse.
c. Navigate to the folder for storing your images.
d. Click Open to enter the Path.
3-6 May 2002
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Validating the Scanner

3. Use the table below only as a starting point for determining Scan Area

values.

NOTE: Keep the Line Offset (y): at the default value of 0 and keep Pixel
Summing at the default value of None.

IMPORTANT: The Pixel Offset must be greater than or equal to the first
calibrated pixel and # Pixels must be less than or equal to the

last calibrated pixel minus the first calibrated pixel.

Cut|:|(§|zzt;l;|lm Magnification | # Pixels | Pixel Offset | # Lines F|I(i/|§|)ze
35 mm double- 0.50 1033 2484 1460 43
perforated 1.03 2129 1936 3008 18.3
2.00 4133 934 5840 69.1
46 mm 0.50 1754 2123 2554 12.8
0.60 2105 1948 3065 185
1.58 5542 229 8071 128.0
6x 4.5cm 0.50 2368 1816 1539 10.4
vertical 0.66 3126 1437 2031 18.2
1.26 5967 17 3878 66.2
6x 4.5cm 0.50 1539 2231 2368 10.4
horizontal 0.66 2031 1985 3126 18.2
1.26 3878 1061 5967 66.2
6x6cm 0.50 2368 1816 2250 15.2
0.55 2605 1608 2475 185
1.26 5967 17 5670 96.8
6x7cm 0.50 2368 1816 2775 18.8
1.26 5967 17 6994 119.4
6x9cm 0.50 2368 1816 3325 225
1.19 5636 182 7914 127.6
Split 70 mm 0.50 2483 1759 1632 11.6
0.63 3129 1436 2056 18.4
1.20 5960 20 3917 66.8
70 mm 0.50 2682 1659 3450 26.5
1.0 5846 77 7522 125.8
4x5in. 0.50 3972 1014 5026 57.1
0.74 5878 61 7439 125.1
max mag 2.00 6000 0 7333 125.9
min mag 0.50 2917 1542 3750 313
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Validating the Scanner

Autofocusing

1. Install a negative or mounted slide in the scanner. (See Selecting the
Negative or Positive Balancing Filter on page 2-8.)

2. Click the Mag/Focus tab.
3. Click Do AutoFocus.

Operations
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Validating the Scanner

Scanning the Image

1. Click the Capture tab.
2. Click Scan.

Checking the Scan
Operatons K|

Mizcellaneous I Diagnostics I Sensang I Matars & Sclenoids |  Backup & Restare
bl ag/Focus I Calibrate/Image Proceszsing Capture I Transfer
— Scan Area —Save Image to Hogt Compuiter
HPixels [dx): |21 oo ¥ Save image to file
Pixel Offzet [x) I-I 330 Path: IE:HEastman K.odak K Pro ApplicationstD
Hlines [dyl: |3|:":”:|
Fil= Size: O Browse |
Lire Offset [y]: ID
Pivel Surmming Im Actual HF=els: 0
v~ Open Image
445 Film Size &ctual Blines: 0O P g |
— Predefined Setupz [uick Calibrate & Focus
Select Setup:l vI Edit setupl
Calibrate &l | Focus |
[ Set Magnification Automatically
— Scan Type Scan
& LivelmageData || .. _ _  ——
#5 Per F 3 {
" |ntemal Test Pattemn #1 =ars TETETEms ! :
Can
" Internal Test Pattern #2 ™ Do Two Pass IR Scan
= Live Image Infrared Data

— Single Line Scan
[ Single Line Scan | Graph Szan Line DensitErofie

1. On the Capture tab, click Open Image.
Adobe Photoshop opens.

2. In Photoshop, enter the required values.
a. Enter the Dimensions:

* Width = Actual #Pixels when Pixel Summing is None.
» Height = Actual #Lines when Pixel Summing is None.
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Validating the Scanner

b. Enter the Channel information:

e Setthe Count to 3.

» Make sure Interleaved is selected.
» Set Depth to 16 Bits.

» Set Byte Order to IBM PC.

3. Click OK.
After a few seconds, the raw image appears.
4. Select Image>Adjust>Auto Levels.
After a few seconds, a clearer image should appear.
5. Select Image>Rotate Canvas>Flip Vertical.
NOTE: You may also need to select Image>Rotate Canvas>90° CCW.

6. Check that the image appears as you expected.

7. If the image does not appear as you expected, repeat this procedure, making
sure you follow the instructions exactly. Then if you still do not get the
expected results, contact your Kodak representative.
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4 Maintaining the Equipment

This chapter contains procedures to be done by the person who is responsible for
maintenance of the HR Film Scanners.

Items required for maintenance are:

» Kodak camel's-hair brush (provided)

« dry, untreated microfiber cleaning cloth
+ lint-free cloth

» white cotton gloves

»  Phillips-head screwdriver

Cleaning Procedures

To minimize the need for cleaning the scanner and to reduce the possibility of
artifacts, make sure your scanner is in a clean, low-traffic area that does not
collect much dust. Wood, tile, linoleum, or sealed concrete floors are preferable to
carpet.

Clean the surface of the scanner with a damp lint-free cloth as needed.

IMPORTANT: Please read the following before performing any cleaning
procedures.

Avoid using pressurized air or canned air near the scanner.

If it is necessary to use canned air to clean film, direct the air
stream away from the scanner.

Instructions for cleaning the balance and IR filters are included under
Replacement Procedures beginning on page 4-2.

IMPORTANT: The balance and IR filters are made of glass and are expensive to
replace. They are not included in the product warranty or service
contract. Use care when handling the balance and IR filters.

When you remove the filters, inspect them. Cleaning may be all that is required.
Otherwise, replace the filters as needed.

Cleaning the Lens

IMPORTANT: Wear white cotton gloves for this procedure to prevent oils and dirt
from being absorbed into the microfiber cleaning cloth.

1. Use the software installed on your host computer to set the magnification to
2.00, which positions the lens as near to the front of the scanner as possible.

2. Clean the front of the lens with the supplied camel’'s-hair brush.

3. Check that the lens is clean; if not, clean with a dry, untreated microfiber
cleaning cloth.
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Maintaining the Equipment

Cleaning the Light Bar

If artifacts appear on your scanned images, clean the light bar.

IMPORTANT: Wear white cotton gloves for this procedure to prevent oils and dirt
from being absorbed into the microfiber cleaning cloth.

1. Fold a dry, untreated microfiber cleaning cloth so the edge of the cloth is
about the thickness of the light bar.

NOTE: You can use an e-wipe, manufactured by Photographic Solutions, Inc.,
instead of a microfiber cleaning cloth.

2. Gently move the edge of the microfiber cloth or e-wipe down the length of the
light bar one time.

3. Calibrate the scanner.

4. If an artifact remains after cleaning the light bar, check the light bar with a
magnifying glass for damage, such as a scratch or a chip. If there is damage
to the light bar, contact your Kodak representative for service.

Replacement Procedures

Replacing the Lamp
White cotton gloves are required for this procedure.

One spare lamp is provided with the scanner.

IMPORTANT: Use only the GE ELC Lamp with the HR Film Scanner (see
Appendix B: Ordering Accessories and Supplies).

It is not necessary to power down the scanner before changing the lamp.

lamp-and-filter-
access door

lift door open from here

1. Open the lamp-and-filter-access door.
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Maintaining the Equipment

Hot Surface
symbol

thumbscrews

lamp cover

2. Loosen the thumbscrews on the lamp cover and pull the cover straight out.

When you remove the cover, the safety switch is released, removing power to
the lamp socket.

CAUTION: Wait at least five minutes for the lamp to cool.

3. Push down the lamp release lever.
4. Remove the old lamp from the lamp socket.
5. Fully seat the new lamp in the socket; polarity is not important.

CAUTION: Inthenext step,to ensure correct alignment with the light bar,
it is extremely important to push the lamp to the back of the
lamp holder with the leads facing to the left. Improper
alignment affects the operation of the scanner.

6. With the socket leads facing left, reinstall the lamp in the lamp holder.
7. Reinstall the lamp cover and tighten the thumbscrews.
Power is reapplied to the lamp socket and the lamp should light.

8. Calibrate the scanner (see Calibrating the Scanner on page 3-5).
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Maintaining the Equipment

Replacing the (Round) Balance Filters

IMPORTANT: The balance filters are made of glass and are expensive to replace.
They are not included in the product warranty or service contract.
Use care when handling the balance filters.

Wear white cotton gloves for this procedure.
It is not necessary to power down the scanner before changing the balance filters.

1. Open the lamp-and-filter-access door (see page 4-2 for the location of the
lamp-and-filter-access door).

balance-filter
assembly

NN
\ re;\balance—filter assembly handle

2. Loosen the thumbscrews on the lamp cover and pull the cover straight out.

When you remove the cover, the safety switch is released, removing power to
the lamp socket.

CAUTION: Wait at least five minutes for the lamp to cool.

3. Position the red balance-filter selection handle of the balance-filter assembly
in the center.

CAUTION: Use care with the IRfilter. It is not secured in place. (For more
information about the IR filter, see Replacing the (Square) IR
Filter on page 4-5.)

4. Hold the red handle and pull the assembly straight out from the scanner.

5. Clean the filters with the camel’s-hair brush or, if needed, replace the filter(s)
as described in the next step.
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Maintaining the Equipment

6. Replace the balance filters:
a. Remove the 3 screws.
b. Remove the filter retainer.
c. Remove the old filters and place the new filters in the filter holder.

The filters are coated on both sides. It is not important which side faces up
or down.

d. Secure the filters with the retainer and the 3 screws.

7. Install the filter assembly in the scanner with the balance-filter selection
handle in the middle.

8. Reinstall the lamp cover, tighten the thumbscrews, and select a filter position.

9. Calibrate the scanner (see Calibrating the Scanner on page 3-5).

Replacing the (Square) IR Filter

IMPORTANT: The IR filter is made of glass and is expensive to replace. It is not
included in the product warranty or service contract. Use care
when handling the IR filter.

Wear white cotton gloves for this procedure.
It is not necessary to power down the scanner before changing the IR filter.

1. Open the lamp-and-filter-access door (see page 4-4 for the location of the
lamp-and-filter-access door).

~

IR filter (under balance-
filter assembly)

\red handle

2. Loosen the thumbscrews on the lamp cover and pull the cover straight out.

When you remove the cover, the safety switch is released, removing power to
the lamp socket.
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Maintaining the Equipment

4-6

CAUTION: Wait at least five minutes for the lamp to cool.

. Position the red balance-filter selection handle of the balance-filter assembly

in the center.

4. Hold the red handle and pull the assembly straight out from the scanner.

5. Push the IR filter up from below the filter assembly.

6. Clean the IR filter with the camel’s-hair brush or, if needed, replace the IR filter

as described in step 7.

CAUTION: Use care with the IR filter. It is not secured in place.

. If replacing the IR filter, set the new filter in place with the arrows on the edges

of the filter pointing down toward the scan lamp.

. Install the filter assembly in the scanner with the balance-filter selection

handle in the middle.

. Reinstall the lamp cover, tighten the thumbscrews, and select a filter position.
10.

Calibrate the scanner (see Calibrating the Scanner on page 3-5).

May 2002

Download from Www.Somanuals.com. All Manuals Search And Download.



Appendix A: Using the Service and

Assembly Module (SAM)

The Service and Assembly Module (SAM) software performs many of the same
functions as other host software. Its primary purpose for users is to validate that
your scanner is working correctly and to allow you to perform simple scan
functions. There are also service and diagnostics functions that should be used
only with the assistance of a Kodak service representative.

Functions supported by the SAM software are:

setting a magnification

calibrating the scanner

setting the image processing mode (negative or positive)

autofocusing at any given magnification

defining the area to be scanned

scanning and transferring images from the scanner to the host computer
performing miscellaneous features such as:

turning the lamp on and off

resetting the lamp-on timer

rebooting the scanner

retrieving scanner usage information
displaying software version information

backing up and restoring critical scanner files

A-1
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Using the Service and Assembly Module (SAM)

Installing the Service and Assembly Module (SAM)

Software
1. Load the SAM CD.
2. Run setup.exe from the SAM CD.
3. Respond to the prompts in the installation program.

You must provide the program location and the name of the program menu
item.

4. When installation is complete, reboot your host computer.

5. Remove the CD and store it in a safe place.

Backing Up Scanner Files

IMPORTANT: It is essential that you back up the scanner files before using SAM.
1. Open SAM.
2. From the Operations window, click the Backup & Restore tab.

3. Click Backup to back up the critical scanner files.

Operations
tag/Focus ] Calibrate/Image Procezsing ] Capture ] Transzfer ]
Mizcelaneous ] Diagnostics ] Sensors ] Matars & Solencids Backup & Restore

Prezzing the Backup button will cause the creation of a backup subdirectary under
"C:AHRB00 SAM" that will contain bwo subdirectones, factony and current. Critical filez from
the zcanner will be copied, one at a time, to these directories, overwriting any pre-exizting files
with the zame names.

Restore will copy the zame files back tothe scanner. |f the files don't exist in the
subdirectonies, the reztore will fall. The error will be reported on a file by file baziz.

Restore

Backup & Restare to/from Specified Location

Folder to Backup to or Restore from:

Browse

A-2 May 2002

Download from Www.Somanuals.com. All Manuals Search And Download.



Using the Service and Assembly Module (SAM)

Using Operations

If the Operations window does not appeatr, select View->Operations.

= HR 500 Service and Assembly Module, Yersion 2.105 M= E3

Test Help

W Tu:u:-ll:-ar .,‘g? | SHU-lTEFlI
—— ' Statuz Bar

Eilm Euntrulsg
Configurations

Color Calibration Scans
Color Matnix Loader
Ewent Logger

[

Operations dialog. Dizk Logging Active Eurrent Punck /
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Using the Service and Assembly Module (SAM)

IMPORTANT: The Diagnostics, Sensors, Motors & Solenoids, and Transfer
tabs are not needed for user functions. Use these tabs only at
the request of your Kodak support representative.

Operations
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Using the Service and Assembly Module (SAM)

Performing the Functions on the Mag/Focus Tab

IMPORTANT: Magnification Calibration should be done only with the guidance of
a Kodak support representative.

From the Operations window, click the Mag/Focus tab when you need to set the
magnification (position of the lens) or do an autofocus.

Operations |
Miscellaneous | Diagrostics I Sensors I Motors & Solenoids I Backup & Restore
Mag/Focus | Calibrate/Image Proceszing I Capture I Transfer

— Magnification
Chosen Magnification: - Do M agnification |

—Focus

Hange:  |300 Do AutoFocus |

R ezulting Pozition in the Range:

Offzet fram Center of Fange: Focus Gluality:

| Graph Focus BualiFie e Eocus EalitEile |

— Magnification Calibration

Target baagnification: 1.00 Calculated baagnification;

Start Pixel: 300 End Pixel: I 5300

Measured Length: I 24.000 E m;ﬁir:negters

LCalculate Magnification I | Update kagnification T able I

— Graph Magnification T able
% Cument  © Factany Graph Magnification T able |

Setting the Magnification

1. On the Mag/Focus tab, select the Chosen Magnification. The value can be
between 0.5 and 2.0.

The scanner’s software maintains an internal Mag/Focus position table that
associates a motor position for each of the possible magnification values.

2. Click Do Magnification.

The lens and CCD move to the chosen position.
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Using the Service and Assembly Module (SAM)

A-6

Performing an Autofocus

1. On the Mag/Focus tab, enter the Focus Range. The recommended value is
300. The Range is the initial range of travel used for the CCD and lens, in
motor steps.

NOTE: To make the focus procedure faster: if you have focused on a given
magnification, you can set the Range value to be less than 300.

IMPORTANT: Autofocus will be done for the Chosen Magnification. It is
assumed that when you do an Autofocus, you have:

« calibrated with an empty film holder (see Calibrating the
Scanner on page A-8)

 placed the film to be scanned in the scanner (see Placing
the Film Holder in the Scanner on page 2-12)

» set the scan area (see “Using the Capture Tab” on
page A-8); for fastest scanning, set the # of pixels (in the
Scan area) to 1000

2. Click Do AutoFocus.
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Using the Service and Assembly Module (SAM)

Performing the Functions on the Calibrate/Image
Processing Tab

From the Operations window, click the Calibrate/Image Processing tab when you
need to calibrate the scanner.

Operations |
Mizcellaneous I Diagnostics | Sensors | Motors & Solencids I Backup & Restare
Mag/Focus Calibrate/Image Frocessing Capture I Transzfer

— Image Procezsing
—DataPath———— ~DminSettihgs————  ~ Colars Selected
¥ Color Megative " Disabled * BRE
™ Color RBeversal & Lse Defaults  Bed
_ _ " User Selected
LUrhT Selected FEI 2Elecle  Green
Dizabled
n: 0.45 e
= Log [Intemal] I I I  Blue
¥ Enable Dark and Gain Corections ¥ Shift Image Data Bits Up by Four
¥ Enable Defective Pixel Conceal

— Calibration Besultz

Exposure Time:  0.00122  Line Length: 100 Calibrate Al
Fed Reset: 2967

First Walid Pixel.  5EE Green Reset: 2583 Dark, Calibrate
Last \ald Pixel: 5404 Blue Reszet: 280

IR Slope: 1622783 View Calibration Logs Donin Calibrate

— Mon-Linearity Factars
Red: Green: Elue: IR: Calibrate ﬂnn-Linearit_l,ll
Graph Gain Carrections Graph Dark Corections |

Setting Image Processing Parameters
1. Select the Data Path.
2. Select the LUT Selected.
3. Select the Dmin Settings.
4. Select the Colors Selected.
5. Select:

 Enable Dark and Gain Corrections
+ Enable Defective Pixel Conceal
» Shift Image Data Bits Up by Four
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Using the Service and Assembly Module (SAM)

Calibrating the Scanner

IMPORTANT: The CAL (70MM-CAL for HR 500 Plus Film Scanner and 4 x 5 for
HR Universal Film Scanner) film holder must be in position in the
scanner before you continue. See Placing the Empty Film Holder in
the Film Holder Guide on page 2-6.

1. If the values on the Calibrate/Image Processing tab do not match the values
shown on the sample on page A-7, change them. The sample is a
representation of the default values.

2. Select Shift Image Data Bits Up by Four.
3. Click Calibrate All.

Using the Capture Tab

From the Operations window, click the Capture tab when you need to perform a

scan.
Operations |
Mizcellaneous I Diagrostice I Senzors I Motors & Solencids | Backup & Restare
Mag/Focus I Calibratelmage Froceszing Capture | Transzfer
—Scan Area — Save Image to Host Computer

HPixels [dx): |21 ol ¥ Save image to file

Pisel Offzet []: |193'J F'ath:l
HLines [dy]: |3'3'JD

File Size: 00 Browse |
Lire Offzet [y]: IU
Pived Summing Im Actual #Pixels: 0
I_' 4}{5 F|||TI SiZE .ﬁ.Ctua| 'ﬁLinES: |:| I:Il:lErl |IT|agE |
— Predefined Setupz Cuick Calibrate & Focus

Select Setup:l vI Edit Setupl

Calibrate All | Focus |
[ Set Magrification Automatically

—5Scan Type Scan
% Live Image Data
#5 Per F g I
" |nternal Test Pattern #1 Fans FETTIEmS 1 .
can
" Internal Test Pattern #2 W s T Pt [ S
" Live Image Infrared Data
— Single Line Scan
[T Single Line Scan T} Graph Sean line DensityEisfie
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Using the Service and Assembly Module (SAM)

Setting the Scan Area

To set the Scan Area, enter values for:

# Pixels (valid values range from 1 through 6002); for fastest scanning, enter
a value of 1000

Pixel Offset (valid values range from O through 6001)
# Lines (valid values range from 1 through 7464)

Line Offset (valid values range from 0 through 7463)
Pixel Summing (valid values are None, 1:2, and 1:4)

NOTE: If you select Pixel Summing of 1:2 or 1:4, use the Actual #Pixels and
Actual #Lines for viewing the image in the Adobe Photoshop program.

Scanning the Image Data

1. If desired, save the scanned image as a file:

a. Enter the Path information (file destination).

b. Select Save image to file.

2. Click Scan.

A-9
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A-10

Using the Miscellaneous Tab

Clicking the Miscellaneous tab on the Operations window lets you:

turn the lamp on and off

reset the lamp timer to zero

reboot the scanner
initialize the scanner
set the scanner clock

get scanner usage information

get scanner attributes
get version information

Click the appropriate button to perform the corresponding function.

Operations Ed |

tag/Focus I Calibrate/Image Procezsing I Capture I Tranzfer
Mizcellaneous I Diagnostics | S enson: | Motorz & Solencids | Backup & Restore
— Mizcelaneous [tems
| Lamp On I Reboat Scanner
Lamp OFf | Initialize Scanner
Fieset Lamp Timer | Set Scanner Clock
— Scanner Information
Get Scanner zage Info | Gt Version Info
Scan Counter: 1153300
Lamp On Tirne; 163.256 hrz. Scanner Firmmware: 03003
Hozt APl Protocal: nz
Get Scanner Attibutes |
Scanner AP Protocal; nz
Serial Mumber: 0103 _
CCD Anay Size: E002 APl DLL Wersion: 03.002
Pixel Fitch [in microns); 12,000 Scan Engine Firmware; 1.93
kdini b ag: 0.50
|n|mum = Other DLL Werzions:
b &irnurn k4 ag: 2.00
. rifcd2. dll 6.0.400
Ciigital ICE Capahble: es :
445 Capable: No whazpid2.dl:  4.60[1021]
# Lapable. YeeedZipdl 401529
Lens Focal Length: 560
May 2002
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Using the Service and Assembly Module (SAM)

Backing Up and Restoring Files

From the Operations window, click the Backup & Restore tab when you need to
perform either a backup or restore of the scanner files.

e Click Backup to back up scanner files.

CAUTION: Use Restore only when recommended by a Kodak support
person.

» Click Restore to copy backed up files to the scanner.

Operations Ed |

bl agd/Focus I Calibrate/Image Processing I Capture | Transfer |
Miscellaneous I Diagnostics I Sensors I Mators & Solenaids Backup & Restare

Prezzing the Backup button will cauze the creation of a backup subdirectary under
"C:AHRB00 SAM" that will contain bwo subdirectones, factony and current. Critical filez from
the zcanner will be copied, one at a time, to these directories, overwriting any pre-exizting files
with the same names.

R estore will copy the zame files back tothe scanner. |f the files don't exist in the
subdirectories, the reztore will fail. The error will be reported on a file by file baszis.

Restore |

— Backup ¥ Restore tofrom Specified Location

Faolder to Backup to or Bestare from;

Browse |

Hackup Eestare |

May 2002 A-11
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Appendix B: Ordering Accessories and
Supplies

Accessories

May 2002

Item Description

Order Number

Manual:

Kodak Professional HR 500 Plus Film & HR Universal 6B7198
Film Scanners User’s Guide

Kodak Professional HR 500 Scanner Long Roll

Accessory 158 5496
Kodak Professional HR 500 35mm Scanner Strip Gate

Accessory 843 0316
Kodak Professional HR 500 Scanner 120 Strip Gate

Accessory 844 0554
Kodak Professional HR 500/Universal Scanner 35 x 45.2

Film Gate 892 3880
Kodak Professional HR 500 Film Holders 890 7776
Kodak Professional HR 500 Carded Negative Film Gates 141 1099

A-Crop
B-Crop
C-Crop
D-Crop
E-Crop
F-Crop
G-Crop
H-Crop
A-Square
B-Square
C-Square
D-Square
E-Square

Download from Www.Somanuals.com. All Manuals Search And Download.
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Ordering Accessories and Supplies

Supplies

B-2

Available Accessories

Item Description

Order Number

Static Elimination Kit
Available from:
Holter Associates, Inc.
1170 Pittsford-Victor Road, Pittsford, NY 14534
Phone: (716) 381-7988; Fax: (716) 381-2351

115 V Kit — Static Elimination Kit

2RSM80-115

230 V Kit — Static Elimination Kit

2RSM80-230

Super Film Cleaner or an equivalent cleaner with ionized
air and particle transfer rollers (PTR)

Super Film Cleaner is available from:

Brooke International

P.O. Box 300

Hansville, WA 98340-0300

Phone: (360) 638-2591; Fax: (360) 630-1658

Polymag Film Strip Cleaner available from:
www.polymagtek.com

Phone: (800) 787-0830

Item Description

Order Number

GE ELC Lamp 106 3189
Microfiber Cleaning Cloths 980 4014
e-wipes
Available from:
Photographic Solutions, Inc.
Phone: (800) 637-3212; Fax: (508) 759-9699
May 2002
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Appendix C: Scanner Specifications

Site Specifications

AC Power Requirements

1,750 watts peak

AC Frequency

50 or 60 Hz

AC Phase

Single

Operating Environment

Room temperature:
Relative humidity:
Ambient light:
Altitude:

65 to 80° F (18 to 27° C)

20 to 70%

less than 1000 lux; no exposure to direct lighting
7000 feet (2134 m) maximum

Scanner Specifications

Dimensions and Weight | Height: 15in. (38,1 cm)
Width: 24 in. (61 cm)
Depth: 30 in. (76,2 cm)
Weight: 120 Ibs (54,5 kg)
Footprint: 5 square feet
Operating and Service Rear: 1.5 feet (45,7 cm) for operation,
Clearances 3 feet (91,4 cm) for service
Sides: 2 feet (60 cm) for operation and service
Front: 4 feet (122,9 cm) for operation and service

Scanner Location

The scanner location relative to the host workstation is limited by the SCSI
interface cable length; if you are using a cable stocked by Kodak, this
distance is 2 meters or less. Longer cables are not supported for use with
the scanner. The scanner must be the only SCSI device attached to the
host computer.

The scanner should be located on a table that:

e is stable

e can support approximately 120 Ibs (54,5 kg)

e isatleast 30in. (76,2 cm) long x 30 in. (76,2 cm) wide

Power Consumption
and Thermal Load

Power Consumption: 425 watts maximum; 400 watts typical
Thermal Load: 1325 BTU operating; 1230 BTU standby

AC Voltage and Current
Draw

100 V AC/50 Hz
100 V AC/60 Hz
120 V AC/50 Hz
200 V AC/60 Hz
200 V AC/50 Hz
230 V AC/60 Hz
250 V AC/50 Hz

4.2 amps operating;
4.1 amps operating;
3.5 amps operating;
2.0 amps operating;
2.0 amps operating; 1.85 amps standby
1.8 amps operating; 1.7 amps standby

1.75 amps operating; 1.65 amps standby

3.9 amps standby
3.85 amps standby
3.2 amps standby
1.9 amps standby

May 2002
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Appendix D: Using the Long Roll
Accessory

The Kodak Professional HR 500 Film Scanner Long Roll Accessory lets you scan
rolls of 35 mm-, 46 mm-, 70 mm-, and 120/220-size edited film.

IMPORTANT: The Long Roll Accessory must not be installed when you scan a

4 x 5-in. image.

Because of the variability of both film editors and scanners, you must:

» set the punch reader height
« calibrate the sensor offsets if you are using SAM to operate your

scanner

» use aperture plates dedicated to your scanner

For the highest quality scans:

» before scanning, to reduce the chance of artifacts, clean the film with Super
Film Cleaner (see Appendix B: Ordering Accessories and Supplies) or an
equivalent cleaner that has ionized air and particle transfer rollers (PTR)

« install and use the appropriate static elimination kit (see Appendix B: Ordering
Accessories and Supplies)

» follow daily maintenance procedures to clean the rollers and the punch
readers on the Long Roll Accessory

» calibrate the scanner for each new roll of film

CAUTION: Kodak recommends that you use one-inch film cores with the

Long Roll Accessory. However, your lab may require that you use
3/4-inch film cores. It is critical that the fast forward and rewind

speeds are correct for the size core you use. The fast forward and
rewind speeds should never be greater than 10inches per second.

If you use

One-inch film cores

3/4-inch film cores

Maximum speed is 10
inches per second.

Maximum speed is 8
inches per second.

DP2 software

Consult your DP2 (Kodak Professional Digital Print
Production Software) documentation.

SAM software

See the instructions on page D-29.

IMPORTANT: Before beginning the following installation procedure, check that
the shipping box contains all items on the packing list. If it does not,
contact your Kodak representative.

Download from Www.Somanuals.com. All Manuals Search And Download.

D-1



Using the Long Roll Accessory

Installing the Software for the Long Roll Accessory

1. With the PC powered off, power on the scanner.

2. Wait for the series of 3 beeps to sound at the scanner (or for the lamp to
illuminate).

You must have version 3.0 or higher of SAM (Service and Assembly Module)
diagnostic software installed on the host computer and version 3.0 or higher of
firmware on your scanner.

Downloading the Software and Firmware from
KODAK.COM
1. Goto:
http://www.kodak.com/global/en/service/software/hr500/navigation.shtml

2. If the version numbers for either the SAM diagnostic software or firmware are
higher than what is now installed on your scanner, follow the instructions on
the Web site to download the newer versions of SAM and the HR 500
firmware.

3. Follow the installation instructions on the Web site.

D-2 May 2002
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Using the Long Roll Accessory

Upgrading the Scanner’s Firmware

Check the Web site (see page D-2) for the most up-to-date instructions.

1. Open SAM and click the Transfer tab on the Operations window.

Operations |
Mizzellaneous I Diagnostics I Senzors I Matars & Solencids I Backup & Restore |
Mag/Focus I Calibrate/lmage Processing I Capture Tranzfer

— Transfer Service & Data Path Filez

1. Select File Type ta Transfer:

2. Select Location on the Scanner: | Current

3. Select Path & Filename on Host:

4. Transfer File Ta ar From Scanner: To Scanner |
FEram SEanier |

Browsze |
WiewEile |

— Restore Scanner Files to Factom Yalues

[ Use Emergency Mominal ¥ alues

Select File to Restare: I Coanfiguration j Restare |

2. Make sure the File Type is Firmware (W).

3. Click Browse and find the .zip file that you downloaded from KODAK.COM

(example: HR500\Px03_000.zip).
4. Click Open.
5. Make sure the Location on the Scanner is Current.
6. Click To Scanner to start the transfer.

The transfer takes approximately one minute.
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Using the Long Roll Accessory

7. When the transfer is complete, select the Backup & Restore tab and click
Backup.

Operations

Er G FEEiare:

8. When the backup is complete, exit SAM.

D-4 May 2002
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Using the Long Roll Accessory

Installing or Removing the Long Roll Accessory

IMPORTANT: Because of manufacturing tolerances, aperture plates and Long
Roll Accessories cannot be interchanged.

If your lab has more than one Long Roll Accessory, you may want
to use labels with the same colors or numbers to identify aperture
plates with the associated Long Roll Accessory.

Overview of Parts

The parts shown below are shipped with the Long Roll Accessory. Although not
shown, 5 aperture plates are also shipped with each Long Roll Accessory.

aperture plate

1.5in. rear
2 mounting screws mounting screw

2 flanges

o
2 guide pins

long screwdriver

w«m@\

—a—C

n

height adjustment
tool

May 2002 D-5
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Using the Long Roll Accessory

Preparing the Scanner for the Long Roll Accessory

You must remove the film holder guide from the scanner before you install the
Long Roll Accessory.

thumbscrews

CAUTION: As indicated in Step 1 below, make sure the scanner is
powered OFF.

1. Power off the scanner.

2. Remove the two thumbscrews and loosen the captive screw.

3. Lift the film holder guide up and off the scanner.

D-6
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Using the Long Roll Accessory

CAUTION: Use canned or pressurized air to remove any dust or debris

from the connector.

2 mounting \g
screws =
|

|

|

|

|

|

(&)
o<
=

connector

2 guide pins \ﬂ

connector

¢ A
\;@

May 2002

4. Inspect and remove any dust and debris from the connector.
5. Remove the two mounting screws on each side of the connector.

6. Insert the two guide pins in the holes from which you removed the mounting

SCrews.

7. Tighten the guide pins with a 1/4-in. open-end wrench.
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Attaching the Long Roll Accessory to the Scanner

CAUTION: Make sure the scanner is powered OFF.

1. Grasp the large rectangular opening to lift and remove the Long Roll
Accessory from the shipping box.

tension arm toward

pressure roller
rear of scanner

housing toward you

rectangular
opening

pressure roller housing
toward you

tension arm toward
rear of scanner

ends

2. Hold the Long Roll Accessory at the ends and carry it to the scanner.

3. Position the Long Roll Accessory so the two pressure roller housings are
toward you and the two tension arms are toward the rear of the scanner.

D-8 May 2002
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Using the Long Roll Accessory

CAUTION: Avoid hitting the light bar and the safety switch on the scanner.

4. Center the alignment blocks on the Long Roll Accessory between the two
dowel pins on the scanner.

lignment|

* block

dowel pin

Long Roll Accessory

5. Gradually lower the Long Roll Accessory to rest in place on the scanner.

D-9
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Using the Long Roll Accessory

CAUTION: When installing the mounting screws in the next step, use
care to avoid

» dropping the screws inside the scanner
» cross threading the screws

mounting
screws

rear mounting ﬁ .
|
screw L

6. Install, but do not fully tighten, the rear mounting screw.

7. Hold each of the two mounting screws at the angle of the holes
(approximately 45 degrees) and install, but do not tighten, the screws.

CAUTION: In the next step, do not overtighten the mounting screws.

8. Using the long screwdriver provided, tighten the 3 mounting screws until you
feel resistance.

D-10 May 2002
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Using the Long Roll Accessory

Latching and Unlatching the Gate Actuator

Be sure you know how to latch and unlatch the gate actuator before installing the
aperture plate. The gate actuator must be in the unlatched position for film loading
and in the latched position for scanning.

Latching the Gate Actuator

CAUTION: Be surethe gate actuator is latched before you move the locking
arm to the locked position.

1. Pull the gate actuator toward you until the gate “latches” in place.

2. To lock the gate actuator, move the locking arm to the left (locked) position.

Unlatching the Gate Actuator

CAUTION: Always move the locking arm to the unlocked position before
unlatching the gate.

To unlatch the gate actuator, manually squeeze the two tabs together and release.

arm in the
unlocked position

2 tabs for
unlatching

D-11
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Using the Long Roll Accessory

Installing the Aperture Plate

IMPORTANT: To power on the scanner without error, an aperture plate must be
installed, latched, and locked.

1. Choose the aperture plate corresponding to the film format you will be
scanning.

lettering on left side

\\.m\lm

\

L~

2. Position the aperture plate with the lettering (example: 120/220) visible on the
left side.

CAUTION: Installing an aperture plate backwards may result in a
damaged light bar.

3. Make sure the gate actuator is unlatched for film loading.

4. Center the aperture plate on the lamphouse cover.

aperture

5. Gently lower the aperture plate and, when you feel resistance, push until it is
secured.

D-12 May 2002
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Removing the Long Roll Accessory from the Scanner
It may be necessary to remove the Long Roll Accessory from the scanner.

CAUTION: Make sure the scanner is powered OFF.

To remove the Long Roll Accessory, reverse the installation procedure (see pages
D-8 through D-12 for more details):

1. Remove the aperture plate from the Long Roll Accessory. See Latching and
Unlatching the Gate Actuator on page D-11.

2. Power off the scanner.

CAUTION: Whenremovingthemounting screws inthenextstep,usecare
to avoid dropping the screws inside the scanner.

3. Loosen and remove the 3 mounting screws.
CAUTION: Avoid hitting the light bar and the safety switch.

4. Remove and lift the Long Roll Accessory from the scanner.

5. Place the Long Roll Accessory on a flat surface.

May 2002 D-13
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Using the Long Roll Accessory

Punch Sensors

The punch (data hole) sensors are set up at the factory for negative-type film and
require no adjustment during the installation procedure. If you will be scanning film
that has a significantly higher or lower D-min from negative film, such as black-
and-white film or color positive film, see Determining and Setting the Trigger
Points on page D-31.

Setting the Punch Reader Height for the Current Film
Size

Because of differences in film editors, there is no standard punch reader height.
You must set the height of the left and right punch readers, one at a time, to
accommodate your editor.

For each film size that you use:

» Install the appropriate aperture plate.

« Adjust the core locator height on the spindle.
* Thread the film.

» Set the punch reader height (this is a one-time adjustment that can be done
during installation or when the aperture plate is used for the first time).

The aperture plate should already be installed. If not, install it (see Installing the
Aperture Plate on page D-12).

D-14 May 2002
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Using the Long Roll Accessory

Adjusting the Core Locator Height on the Spindle

The spindles on the Long Roll Accessory have core locators to accommodate
different film sizes.

@\\*j

detent for
35 mm

ggtﬁan;for / 8 core locator
detent for /

120/220

\
detent for% = S
70 mm ‘ \

button

Push and hold the button to release and position the core locator at the correct
detent. Release the button at the detent you want. The detent positions are:

e 35 mm (top)

e 46 mm

e 120/220 (62 mm)

e 70 mm (bottom; closest to Long Roll Accessory)

May 2002 D-15
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Using the Long Roll Accessory

Loading and Threading Film

IMPORTANT: Careful handling of film is extremely important. Before loading film,
clean the film with Super Film Cleaner or an equivalent cleaner that
has ionized air and particle transfer rollers (PTR).

Use canned air to clean the punch readers before threading film.

Before loading film, make sure you have at least 2 feet (.6 meters)
of leader at each end of the roll.

CAUTION: In the steps below, be sure you determine and use the correct
orientation of the flange. Incorrect setup will resultin film tracking
problems and loose takeups.

1. Determine the orientation of the flange for the reel or core you selected for
loading:

» A flange in the upright position is for thin reels
» Aflipped flange is for film on cores
* No flanges are needed for thick reels

(]

THIS SIDE UP FOR THIN REEL
REMOVE FOR THICK REEL

or

THIS SIDE UP FOR CORE ONLY
REMOVE FOR THICK REEL

spindle

2. If you are using either thin reels or core only, install the flanges on the spindles
with the appropriate side up.

D-16 May 2002
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Using the Long Roll Accessory

Threading the Film

1. Position the film with the data holes down and the emulsion toward the
imager.

emulsion side

data holes

You can thread the film from either side of the Long Roll Accessory.

2. Install the film on the spindle.

idler arm

spindle

\ drive roller
8

aperture

3. Thread the film:
a. around the idler arm
b. around the drive roller

c. between the aperture and the clamp, keeping the film in the track (grasp
the film on either side to locate the film in the track)

d. around the drive roller and idler arm

May 2002 D-17
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Using the Long Roll Accessory

4. After the film is threaded, pull the gate actuator forward to latch it against the
aperture plate. Move the locking arm to the left (locked position).

gate actuator

arm in the
locked position

Setting the Punch Reader Height
1. Open SAM.

2. Click the LAMP button to turn the lamp off. When the lamp is off, it is easier to
work in the area of the punch reader.

O|@ || & | ® | ¥ | sHutter| Lamp | cLamp |uncLamp

|
toggles to turn the lamp off and on

D-18 May 2002

Download from Www.Somanuals.com. All Manuals Search And Download.



May 2002

3. Select View>Film Controls.

Film Cont__ |4 |

Load Film

Tenzion Off

Load Firzt Frm
Iext Erame

Eress Erame
Seek Erame

Eead et

Eead Eres:
< Position

Paosition >

Fast Fiard >

Clean Rallers

Stap

4. Click Load Film.
A dialog box appears.
5. Click OK.

Using the Long Roll Accessory

6. In preparation for the reader height adjustment, click Fast Fwrd>> to advance
the film approximately 10 feet, then click <<Rewind to reverse the film the

same distance.

NOTE: Advancing and rewinding the film ensures that the film is correctly
positioned in the film track relative to the readers.

D-19
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Installing the Adjustment Tool
1. Locate the left and right adjusting screws on either side of the aperture plate.

2. Install the height adjustment tool in the right or left adjusting screw.

NOTE: You will install the adjusting tool in each adjusting screw; whether it is

the left or right screw is determined by which punch reader you adjust
first.

height adjustment tool

punch reader

§

adjusting screw

adjusting screw

\\:&\nm

adjusting screw

\
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Visually Checking the Punch Reader Height

1. Look at the small blue light located in the notch at the top of the punch reader,
which is below the pressure rollers and adjacent to the edge of the aperture.

The blue light should be in line with the punches in the film.

2. Align the light to the data holes by turning the adjusting screw clockwise to
lower the light or counterclockwise to raise the light.

'd punch reader

adjusting screw

D-21
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Adjusting the Punch Reader Height

Adjust both the left and right reader heights such that the punch reader fully
distinguishes between a data hole and film.

No specific numbers represent data holes or film, but lower numbers indicate the
presence of film and higher numbers indicate the presence of data holes. (See
Recording the Highest Numbers on the LEDs on page D-31 for the location of the
LED numbers.)

For both the left and right readers:

1. On the Film Controls window, click Position > several times to advance the
film. As you advance the film, the reader should sense both holes and film.

If you do not see a significantly higher number after you see data holes,
repeat Visually Checking the Punch Reader Height on page D-21

2. When you see a significantly higher number, stop advancing the film. Turn the
adjusting screw until the number is maximized.

For example, as you click Position >, you may see a value of 580, but when
you stop advancing the film and turn the adjusting screw, you may see a value
of 620. This indicates a more effective reader height.

3. Repeat steps 1 and 2 to advance the film to another position and confirm your
adjustment.

4. From SAM, turn the lamp on.

When the above procedures have been completed, you can begin scanning. Use
your Kodak Professional Digital Print Production Software (DP2) (help is included)
to produce quality scans.

IMPORTANT: Remember to recalibrate the scanner for each roll of film. Use a
camel’s hair brush and canned air to remove dirt or dust from the
light bar.
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Appendix D-1: Calibrating the Sensor Offsets

May 2002

scanner.

Preparing and Loading the Film

IMPORTANT: Do this procedure only if you will be using SAM to operate the

Do this procedure twice, once for the left sensor and once for the right sensor. For
best visibility, use the largest film format you have.

It is not necessary to prepare and load the film twice.

1. Create a roll of film with the center of several frames clearly marked.

L center

2. Edit the roll of film, making sure to center the mark in the crop box on the

editor.

3. Load the edited film, beginning at the left side of the scanner (see Loading

and Threading Film on page D-16).
4. In SAM, select View>Film Controls.

Film Cont... |4 |
Laad Film

Tenzion Off
Load First Frm
extErane

Erew Erame
Seek Erame

Head et
Head Eresw:
< Pozition

Position >

Fast Frrd =

Clean Rallers

Stop

5. Click Load Film.

6. When the dialog box appears, click OK.

D-23
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Setting the Lens Magnification

1. If the Operations window is not visible in SAM, select
View>Operations Controls.

Operations

I | Grapt Fosus WuaEtfHE [0 e o [ e

2. Select 1.00 as the Chosen Magnification.
3. Click Do Magnification.
4. Close the Operations window.

D-24
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Using the Long Roll Accessory

Setting the Scan Parameters
1. Select Test>Long Roll Capture from the SAM menu.

Long Roll Capture Test Ed

Test Cocle Setup —Scan And Pozitianing [nfo. — Contralz
Baze Directorny: I HPinels [dx] B0

Start Scanning

E Fimel Offzet [x]: |'|5|:“:|
& Don't ‘Wit the Image to a File ﬁl el Qiffset () [«'\\f
Hlinez [dy] |35':":|

i | I Ease
= L Offzet [v]: 0 -
Generate File Mames from Punch Mumber ine == LI'J]

[T Don't Stop Test On Erors
Pixel Summing: IN':'”E’ :I'

 Always Write to Test File [T estS can.raw]

[ Delay 10 min after 2000 scans [Eamtinue
Mumber Of Cycles Ta Bun: I 1
umber weles To Run  Offset L001") IEI—
Mumber of Frames/Cycle To Scan: I 50 Stop
I 1]

MHurnber Of Frames Between Scans:

— Input Output Status

— Statistics
Last Frame's Rate: 0 Foundin1 Retny: 0O S canning: |
Awg. sec./ frn 1] :;':'u”j ?n ; EE“?ES: g ¢
. aund In 3 Hetnes: Wwiiting To Disk:
s s &/ L Found in 4 Retriez: 0 |
Total Frames: 0 Mot Found: 0 e, 1
File Size: 1]
Taotal Cycles: 0 Beset Statisticsl
2. Set the Scan and Positioning Info.
a. Setthe #Lines (dy) to 1.
b. Setthe Line Offset (y) to 0.
c. Set Pixel Summing to None.
d. Keep the default values for #Pixels (dx), Pixel Offset (x) and X Offset.
IMPORTANT: Make sure you close the Test Long Roll Capture window in the
next step.
3. Close the Test Long Roll Capture window.
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Using the Long Roll Accessory

Locating the First Punched Frame

1. On the Film Controls dialog box, click Load First Frm. A dialog box appears.

Film Loading

TOSTART A ROLL, vOU MUST SET THE FIRST
PUNCH MUMBER &AMD THE DIRECTION THAT THE
FILM %/ILL BE PROCESSING.

First Punch Mumnber: I.-|

Filrn Proceszing Direction

" Fomward [Left To Right]

" Reverse [Rlight Tao Left)

Cancel | Go I

]|

2. Select the Film Processing Direction:

» If you are calibrating the left sensor offset, select Forward (Left to Right).
» If you are calibrating the right sensor offset, select Reverse (Right to

Left).
3. Type -1 in the First Punch Number field.

-1 tells the scanner software to find the first punch (in the specified direction).

4. Click Go.

Dizk Logaing Active |[Current Punch = 100 | Target Punch =000 |

| .

The status bar shows the Current Punch (the first punch found). The example

shows that the first punch found is 100.
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Dizk Logging Active

Using the Long Roll Accessory

5. On the Film Controls dialog box, click Seek Frame.

Film Cont__ |4 |

Load Film

Tenzion Off

Load Firzt Frm

Iext Erame

Eress Erame

Seek Erame

Eead et

Eead Eres:
< Position

Paosition >

Fast Fiard >

Clean Rallers

Stap

A dialog box appears.

Seek Frame

Enter the Punch Mumber that you wizh to

Locate:

100

_ Carcel |

]

6. Type the Punch Number from the Current Punch on the status bar.

7. Click Go.

[Current Punch = 100 | Target Punch = 100 | | |

The Target Punch should equal the Current Punch.
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Using the Long Roll Accessory

Checking the Alignment and Adjusting the Sensor
Offsets

1. Using a flashlight, look from the rear of the aperture to check the alignment of
the marked frame with the aperture plate.

The center of the frame should line up exactly with the right edge (from the
front of the scanner) of the aperture plate.

NOTE: The area beyond the aperture plate is not visible when you are
checking the alignment.

Center of the frame Center of theframeis Center of the frame
lines up exactly with beyond the edge of has not reached the
the right edge of the  the aperture plate edge of the aperture
aperture plate plate

Filmis

moving left

to right

Film is

moving

right to left
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Using the Long Roll Accessory

2. In SAM, select View>Configurations.

Configurations E |

Filrn &dvance I

Film Marking Type: PLINCH MARKING

Fast Fyard # Fewind Speed: IE— Inches per sec.
Seek Speed: IE_ |nches per zec.
Left Senzor Offzet: |12_ Inches

Right Senzar Offzet: IF |hzhes

Steps Per Inch 975 Steps

M axirurn Seek Distance: |4|:|— Inches

Default Move Distance: Ir Inches
Pasition Button |nerements: IW Inches

k. I Caricel | Lol | Help

CAUTION: Fast Fwrd / Rewind Speed should never be greater than 10. If
needed, change the speed to be 10 Inches per sec. or less.

As a guideline, the speed should be 10 inches per second if
you use l-inch film cores (the recommended size). The speed
should be 8inches per second if you must use 3/4-inch cores.

3. Make sure the correct Film Marking Type is selected and that the Left and
Right Sensor Offsets are correct for the film and the editor you are using.

a. For Offset Punch Editors, set the Left Sensor Offset to 12 and the Right
Sensor Offset to 0.7.

b. For Center Punch Editors, set the Left Sensor Offset to 7.75 and the
Right Sensor Offset to 4.95.

4. Set Position Button Increments to 0.05 inches.

This number determines the distance film is moved when you click the
Position> button on the Film Controls window when setting the reader height.

5. Click OK.
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Using the Long Roll Accessory

6. If the marked frame is not aligned with the right edge of the aperture plate,
select View>Configurations.

Configurations I

Filrn Advance I

Filmn Marking Tupe: PLINCH MARKIMNG

Faszt Fwrd / Rewind Speed: IE_ Inches per sec.
Seek Speed: IE— Inches per zec.
Left Senzor Offset: |12— Inches

Right Sengor Offzet; IF |nches

Stepz Per Inch: IF Stepz

b aximum Seek Distance: |4|:|— Inches

Diefault Move Distance: Ir Inches

Fosition Buttan [ncrements: 0.05 Inches

k. I Canicel | [ | Help

a. If the film is moving from left to right, change the Left Sensor Offset:

If the center of the frame is beyond the right edge of the aperture plate,
decrease the Left Sensor Offset.

If the center of the frame has not reached the right edge of the aperture
plate, increase the Left Sensor Offset.

b. If the film is moving from right to left, change the Right Sensor Offset:

If the center of the frame is beyond the left edge of the aperture plate,
decrease the Right Sensor Offset.

If the center of the frame has not reached the left edge of the aperture
plate, increase the Right Sensor Offset.

7. On the View Controls window, click Next Frame.

8. Repeat steps 1 through 7 until the center of the frame lines up exactly with the
right edge of the aperture plate.

9. On the View Controls window, click Fast Fwrd>> to advance the roll of film to
the right side.

10. Repeat Locating the First Punched Frame (see page D-26) and Checking the
Alignment and Adjusting the Sensor Offsets (see page D-28) for the right
Sensor.
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astic cover

Using the Long Roll Accessory

2. Determining and Setting the Trigger

IMPORTANT: Do this procedure only if you will be scanning film that has a
significantly higher or lower D-min from negative film, such as
black-and-white film or color positive film.

1. With the PC powered off, power on the scanner.

2. Wait for the series of 3 beeps to sound at the scanner (or for the lamp to
illuminate).

3. Power on the PC.

Recording the Highest Numbers on the LEDs
IMPORTANT: There must not be film in the scanner.
1. Open the plastic cover.

2. Look at the red LED number on the right side of the Long Roll Accessory.
Note this number as being the “highest” number on the right side.

N N’ N’
O I V() (eacH | aps[ > wmopE
" "' "'SET EJUNL m—1D

3. Look at the red LED number on the left side. Note this number as being the
“highest” number on the left side.

4. Record the left and right highest numbers for later calculating the trigger
numbers.

Because the readers are separate, the left and right numbers will not be the
same.

The trigger number tells the scanner when it senses a change in light level. You
need to set the trigger number only once unless you will be using the scanner for
multiple types of film, such as for both negative and positive.
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Using the Long Roll Accessory

D-32

Determining the Left Trigger Point

1. On the Film Controls window of SAM, click Position > to advance the film and

determine the “average” low number (indicating the presence of film) on the
left LED.

An example is 120.

. Subtract the average low number from the highest number you recorded in

step 3 under Recording the Highest Numbers on the LEDs.

An example of the highest number is 800. Subtracting 120 from 800 results in
680.

. Divide the result of step 2 by 4.

Continuing the example, 680 divided by 4 equals 170.

. Add the result of step 3 to the average low number determined in

step 1.
The result is the left trigger point. Record this number.

Continuing the example, 170 added to 120 equals 290; 290 would be the left
trigger point.

Determining the Right Trigger Point

1. On the Film Controls window, click Position > to advance the film and

determine the “average” low number on the right LED.

. Subtract the average low number from the highest number you recorded in

step 1 under Recording the Highest Numbers on the LEDs.

3. Divide the result of step 2 by 4.
4. Add the result of step 3 to the average low number determined in

step 1.
The result is the right trigger point. Record this number.

Below are examples of determining trigger points. Round to the nearest whole
number.

Startin Difference
Average Low High 9 Between High Difference Trigger
Number 9 Number and Low | Divided by 4 Number
Number
Number
120 800 800 - 120 = 680 680/4 =170 170 + 120 = 290
98 814 814 -98=716 716/4 =179 179 + 98 = 277
May 2002
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Using the Long Roll Accessory

Setting the Trigger Points at the Scanner

'_J
O TEACH <:] ADJ D MODE
SET :E?,UN L m—D

1. On the left side of the scanner:
a. Move SET/ADJ/RUN to ADJ.

b. Press MODE to increment the number (or press TEACH to decrement the
number) to the value you determined to be the left trigger point.

c. Move SET/ADJ/RUN to RUN.
2. On the right side of the scanner:
a. Move SET/ADJ/RUN to ADJ.

b. Press MODE to increment the number (or press TEACH to decrement the
number) to the value you determined to be the right trigger point.

c. Move SET/ADJ/RUN to RUN.

3. Close the plastic cover.

plastic cover
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Using the Long Roll Accessory

Appendix D-3: Maintenance

Perform these maintenance procedures at least once a day.
1. In SAM, select View>Film Controls.
Film Cont... |4 |
Load Film

Tenzion Off
Load First Frm
et Erarmie
Hres. Erafie

aeek Bramie
Eead fewt

Eead Erew:
< Position

Position >

Fast Frrd =

Clean Rallers

Stop

2. Click Tension Off and remove film from the gate.

It is not necessary to completely unthread the film.
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Using the Long Roll Accessory

Cleaning the Punch Readers

1. Locate the two punch readers, below the pressure rollers and adjacent to the
left and right edges of the aperture.

)
S o S
S p
(=]

O
O
O

=
&
/\/J& two punch readers

2. Use canned air to clean the left and right punch readers.
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Using the Long Roll Accessory

Cleaning the Rollers
1. In SAM, select View>Film Controls.

Film Cont__ |4 |

Laoad Filrn
Tenzion Off
Load First Fron
ezt Erame
ey, Eramie
Zeek Eramie
Fread et

== im || =
< Position

Paosition >

Fast Fiard >

Clean Rallers

Stap

2. On the Film Controls window, click Clean Rollers.
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Using the Long Roll Accessory

A dialog box appears.

SAM =
@ The filn MUST be REMOVED ta clean the rallersil]

Hasz the film been removed?
Mo |

3. Make sure no film is in the gate. Click Yes.

The rollers rotate.
CAUTION: In the step below, do not use rubbing alcohol.

4. Using a lint-free cloth with 90% or higher isopropyl alcohol, wipe the exposed
part of the moving rollers—in the slot at the rear of the housing—from top to
bottom. Repeat until the cloth stays clean.

5. On the Film Controls window, click Stop.
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Using the Long Roll Accessory

Appendix D-4: Initial Setup of Sensors

IMPORTANT: Do this procedure only if you installed a new sensor or if the sensor
setup was accidentally changed.

Resetting the Sensors to the Factory Values

(=4
S |
’_J
O TEACH G ADJ D MODE
- SET -EIUN L D
A
1. Move SET/ADJ/RUN to SET.
2. Simultaneously, press and hold TEACH and MODE until nO ? appears (about
5 seconds).
_
O = (eaci_ | apa[ > wmope
LI ) SET-—‘EJUNL-:D
L JE
NOTE: To cancel resetting the sensors to the factory values, press MODE.
3. Press TEACH until yES? appears.
_
O () ) _(teacH JApi[ > moDE
e ) -—‘:_R,UNL —
L Je |
4. Press MODE.
5. Move SET/ADJ/RUN to RUN.
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Using the Long Roll Accessory

Programming the Sensors for the Long Roll
Accessory

Power on the scanner.

The display on the left sensor will be inverted.

Programming the Left Sensor
1. Open the plastic cover on the left display.
2. Make sure the operation mode selector is setto L.

NOTE: L means that light triggers high numbers. D means that dark triggers
high numbers.

—

O TEACH <:] ADJ D MODE
SET -—‘EQIUN L -\: D

operation mode selector

plastic cover

3. Move SET/ADJ/RUN to SET.
4. Press and hold MODE until d123 appears (123 is inverted).

—
= |
O O T(» teacH Japs[ > wmope
i Ol ) ey RN Lm0 | ] |
5. Press TEACH.
D-39
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Using the Long Roll Accessory

6. Change the Detection Function Setting to F HS (high speed):
a. Press and hold MODE until F St appears.

N N
O :- . )_ teacH<_ Jap3[ >mopE

' "am SET RUN L m—D

b. Press TEACH once. F Ld appears.
c. Press TEACH again. F HS appears.
d. Move SET/ADJ/RUN to RUN.

Programming the Right Sensor
1. Open the plastic cover on the right display.
2. Make sure the operation mode selector is setto L.
3. Move SET/ADJ/RUN to SET.
4. Change the Detection Function Setting to F HS:
a. Press and hold MODE until F St appears.
b. Press TEACH once. F Ld appears.
c. Press TEACH again. F HS appears.
d. Move SET/ADJ/RUN to RUN.
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Using the Long Roll Accessory

Appendix D-5: Table of Scan Area Values

May 2002

Use the table below only as a starting point for determining scan area values.

Long-Roll Magnification | # Pixels | Pixel Offset | #Lines File Size
Film Holders (MB)
35 mm double- .50 1020 2490 1538 4.5
perforated
1.03 2102 1949 3168 19.1
2.00 4081 960 6151 71.8
35 mm .50 1259 2371 1741 6.3
unperforated
1.03 2594 1703 3586 26.6
2.00 5038 481 6964 100.4
46 mm .50 1752 2124 2381 11.9
.60 2102 1949 2858 17.2
1.58 5535 233 7525 119.2
6x4.5cm .50 2378 1811 1539 10.5
vertical
.66 2616 1431 2031 18.2
1.26 5993 4 3878 66.5
6 x6cm .50 2378 1811 2250 15.3
.55 2616 1692 2475 18.5
1.26 5993 4 5670 97.2
6x7cm .50 2378 1811 2775 18.9
1.26 5993 4 6994 119.9
6x9cm .50 2378 1811 3495 23.8
1.16 5517 242 8108 128.0
Split 70 mm .50 2720 1640 1632 12.7
.63 3427 1287 2056 20.2
1.10 5984 8 3591 61.5
70 mm .50 2720 1640 3625 28.2
1.06 5766 117 7685 126.8
D-41
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Using the Long Roll Accessory

Appendix D-6: Film Splicing and Editing Guidelines

Follow these guidelines to ensure the scanner correctly reads the data holes.

IMPORTANT: When splicing rolls of film, always splice first, then edit.

NOTE: The drawings are not to scale.

Because the splice material splice material
is sticky, it is possible for I
Use care with | residue to remain on the
sticky splice | splice material after editing.
material Ensure that light can shine
through all holes. ©O 000 00] 060]0.0 0 O
film—"
Be careful to avoid
Avoid over- accidentally punching a
punching frame twice, which results in
too many holes for the
scanner to interpret. OOOOD OO o olooo o o o
Too much splice material is
cut, causing incomplete
punches.
O 000 0O0F""H0 00O
Cut splice
material flush
with the film
Not enough splice material
is cut. This will interfere with
correct film tracking.
O 000 0OO| 00|00 00 O
Make sure The punches are on the
editing results edge of the film. The
in holes punches must be
entirely within | completely within the
the frames frames. A
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Numerics

4 x 5 film holder for HR Universal Film Scanner 1-6, A-8
70MM-CAL film holder for HR 500 Plus Film Scanner 1-6,
A-8

A

AC input module 2-2
AC voltage and current draw C-1
AC voltage setting, changing 2-3 to 2-4
accessories, ordering B-1
adjustment tool for Long Roll Accessory, installing D-20
air
canned or pressurized 4-1, D-7, D-16, D-35
ionized D-1, D-16
altitude, maximum (operating environment) C-1
ambient light (operating environment) C-1
autofocusing the scanner 3-8, A-5, A-6

B
backing up data files 3-3, A-2, A-11, D-4

C

cables, attaching power and SCSI 2-5
calibrate/image processing tab (SAM) A-7 to A-8
calibrating the scanner 2-8, 3-5, A-8

when to do 1-3, 2-9, 4-2, 4-3, 4-5, 4-6
capture tab (SAM) A-8 to A-9
cleaning procedures 4-1 to 4-2, D-35 to D-37

balance filters 4-4

IR filter 4-6

lens 4-1

light bar 4-2

punch readers on Long Roll Accessory D-35

rollers on Long Roll Accessory D-36 to D-37
clearances, for operation and service of scanner C-1
configuration, recommended for the host computer 1-5
connecting the scanner 2-2 to 2-5

attaching the cables 2-5

changing the AC voltage setting 2-3 to 2-4
connector on scanner, cleaning D-7
core locator height on spindle of Long Roll

Accessory D-15

D

dataplate 1-4

depth of field 2-13

dimensions and weight of scanner C-1

downloading software and firmware for the
Long Roll Accessory D-2

dust 4-1, D-22

E

Electrical Hazard symbol vi

May 2002

Index

e-wipes, for cleaning the light bar 4-2
ordering B-2

F

fast forward or rewind speed
on Long Roll Accessory D-1, D-29
FCC compliance v
film cleaner D-1
ordering B-2
Film Controls window (SAM), for the Long Roll
Accessory D-19
film cores for the Long Roll Accessory D-1
film holder guide 2-6
removing from the scanner D-6
film holders, cut-gate
placing in the scanner 2-6, 2-12
provided with scanner 1-6
film reader height on Long Roll Accessory
visually checking D-21
film sizes 1-6
filters, balance
cleaning 4-4
replacing 4-4 to 4-5
filters, IR
cleaning 4-6
replacing 4-5 to 4-6
firmware, upgrading D-3 to D-4
flange, orientation of, on Long Roll Accessory D-16
focusing 2-13
when to do 1-3
see also autofocusing
Fuse label vi

H

host computer, configuration 1-5
Hot Surface symbol vi
humidity, relative (operating environment) C-1

image processing parameters, setting A-7
initializing sensors for the Long Roll
Accessory D-38 to D-40
initializing the scanner A-10
installing
Long Roll Accessory on scanner D-5 to D-12
SAM on the host computer A-2
IR filter
cleaning 4-6
replacing 4-5 to 4-6
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Index

K

K-number, on scanner vii, 1-4

Kodak Professional Digital Print Production Software
(DP2) 1-3, D-1, D-22

Kodak Professional HR 500 TWAIN Data Source 1-3

L

lamp
replacing 4-2 to 4-3
turning on and off A-10, D-18
lamp timer, resetting to zero A-10
lamp-and-filter-access door 2-8, 4-2
latch release screw 1-4
lens, cleaning 4-1
light bar D-12
cleaning 4-2
loading and threading film on the Long Roll
Accessory D-16 to D-18
location of scanner (specifications) C-1
Long Roll Accessory D-1 to D-42
attaching to scanner D-8 to D-10
calibrating sensor offsets D-23 to D-30
fast forward or rewind speed D-1, D-29
initializing sensors D-38 to D-40
installing accessory on scanner D-5 to D-12
installing software D-2 to D-4
loading and threading film D-16 to D-18
maintaining D-34 to D-37
parts shipped with D-5
punch sensors D-14
removing from scanner D-13
setting punch reader height D-14 to D-22
setting trigger points D-31 to D-33
splicing and editing guidelines D-42
table of scan area values D-41
threading diagram D-17

M

mag/focus tab (SAM) A-5 to A-6
magnification, setting 2-8, 3-4, A-5
maintaining the scanner 4-1 to 4-6, D-34 to D-37
cleaning procedures 4-1 to 4-2
Long Roll Accessory maintenance D-35 to D-37
replacement procedures 4-2 to 4-6
balance filters 4-4 to 4-5
IR filter 4-5 to 4-6
scanner lamp 4-2 to 4-3
Mechanical Hazard symbol vii
miscellaneous tab (SAM) A-10

N

negative or mounted slide, inserting in the scanner 2-10

negative or positive balancing filter, setting 2-8 to 2-9

O

operating the scanner 2-8 to 2-13
focusing 2-13
inserting a negative or mounted slide in the
scanner 2-10
placing the film holder in the scanner 2-12
preparing an uncarded negative
or a mounted slide 2-11
scanning a single frame 2-13
selecting negative or positive balancing
filter 2-8 to 2-9
setting the magnification and calibrating
the scanner 2-8
setting the scan parameters 2-8
operations tabs (SAM)
backup 3-3, A-2, A-11
calibrate/image processing A-7 to A-8
capture A-8 to A-9
mag/focus A-5to A-6
miscellaneous A-10
ordering information B-1 to B-2
accessories B-1
supplies B-1

P

parts shipped with Long Roll Accessory D-5
phone numbers

service agreement information viii

service and support vii
power consumption and thermal load of scanner C-1
power switch 1-4, 2-7
powering up the scanner and the host computer 2-7
punch readers on the Long Roll Accessory

cleaning D-35

setting height D-14 to D-22

R

readers, punch. See punch readers
rebooting the scanner A-10
regulatory information v

removing the Long Roll Accessory from the scanner D-13

replacement procedures 4-2 to 4-6

rollers on the Long Roll Accessory, cleaning D-36 to D-37

S

SAM. see Service and Assembly Module
scan area values

for cut-gate film holders 3-7

for the Long Roll Accessory D-41
scan area, setting, in SAM 3-6 to 3-7, A-9
scan parameters, setting 2-8
scan, checking 3-9 to 3-10
scanner attributes A-10

May 2002

Download from Www.Somanuals.com. All Manuals Search And Download.



scanner specifications C-1
AC voltage and current draw C-1
clearances, for operation and service of scanner C-1
dimensions and weight C-1
location C-1
power consumption and thermal load C-1
scanning
a single frame 2-13
an image using SAM 3-9, A-9
SCSI host adapter 1-5
SCSil interface between host computer and scanner 1-5
sensor offsets on the Long Roll Accessory,
calibrating D-23 to D-30
sensors, punch (data hole) on the Long Roll
Accessory D-14
serial number on the scanner 1-4
Service and Assembly Module (SAM) A-1 to A-11
installing on the host computer A-2
operations controls A-3 to A-11
backing up data files 3-3, A-2, A-11
calibrating the scanner A-8
performing an autofocus A-6
scanning the image data A-9
setting image process parameters A-7
setting the magnification A-5
setting the scan area A-9
starting 3-2 to 3-3
service, obtaining vii
shutting down the scanner 2-13
site specifications C-1
AC power requirements, frequency, and phase C-1
altitude, maximum (operating environment C-1
ambient light (operating environment) C-1
humidity, relative (operating environment) C-1
temperature, room (operating environment) C-1
slide, mounted, preparing 2-11
software
installing for the Long Roll Accessory D-2 to D-4
installing SAM 2-1, A-2
requirements for host computer 1-5
specifications
scanner C-1
site C-1
splicing guidelines for the Long Roll Accessory D-42
starting up the scanner system 2-6 to 2-8
placing the empty film holder in the scanner 2-6
powering up the scanner and the host computer 2-7
static elimination kit D-1
ordering B-2
supplies, ordering B-2
symbols, cautionary, on equipment vi to vii
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Index

T

tables of scan area values

for cut-gate film holders 3-7

for Long Roll Accessory D-41
temperature, room (operating environment) C-1
threading diagram for Long Roll Accessory D-17
threading film on the Long Roll Accessory D-16 to D-18
time, scanner, getting A-10
trigger points on Long Roll Accessory, setting

D-31to D-33

U

uncarded negative, preparing 2-11
unpacking instructions iii
usage information, getting A-10

\Y

validating operation of the scanner 3-1 to 3-10
autofocusing 3-8
calibrating the scanner 3-5
checking the scan 3-9 to 3-10
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